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Confidential Business Information 
This documentation is proprietary information of New Mexico State University (NMSU) and is 
not to be copied, reproduced, lent or disposed of, nor used for any purpose other than that for 
which it is specifically provided without the written permission of NMSU. 

 

Prepared For: Release 7.x 

Prepared By: 
New Mexico State University 

P.O. Box 30001 

Las Cruces, New Mexico 88003 

United States of America 

 

Issued: October 2006 

In preparing and providing this publication, NMSU is not rendering legal, accounting, or other 
similar professional services. NMSU makes no claims that an institution’s use of this publication 
or the software for which it is provided will insure compliance with applicable federal or state 
laws, rules, or regulations. Each organization should seek legal, accounting and other similar 
professional services from competent providers of the organization’s own choosing. 

© 2006, Regents of New Mexico State University. 

© 1992-1995, 1997, 1999-2002, 2003, Systems & Computer Technology Corporation. All rights 
reserved. The unauthorized possession, use, reproduction, distribution, display, or disclosure of 
this material or the information contained herein is prohibited. 

 
“SCT,” SunGard SCT, the SCT logo, “Banner” and the Banner logo are trademarks of SunGard 
SCT. Third-party hardware and software product names and trademarks are owned by their 
respective third-party owners/providers, and SunGard SCT makes no claim to such names or 
trademarks. 

Use of this material is solely for the support of SunGard SCT Banner products and New Mexico 
State University. 

For more information about this document, contact training@nmsu.edu. 
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Overview of Processing Transactions 
When you process transactions you may complete several types of activities, including 
reviewing student accounts, entering transactions, posting charges and payments, and 
correcting transactions. Detail codes are the single most important data element that links 
Accounts Receivable to Finance through the interface process. All of the accounting information 
is maintained through the detail codes. Each detail code has at least one debit and one credit 
account attached to it. 

Navigating Multiple Forms Tips for Transaction Processing 
Sessions 
When you conduct transaction processing-related processes, you may have multiple forms 
open during a single Banner session. When you access multiple forms, and if you need to move 
back and forth from one form to another, you need to remember two important things to 
successfully navigate between forms: 

• You can’t minimize Banner forms to “get them out of the way” so that you can view the 
Main Menu, or other forms that you have opened 

• You can select Return to Menu from the File menu of any form you have already 
opened. 

If you select the Return to Menu option, all forms that you have opened will 
close. Banner does not have the “Back” and “Forward” arrow buttons that you 
may be accustomed to using when you are using the Internet or other systems. 
 

You may prefer to open additional forms directly from the File menu located in the upper left 
area of any form. If you choose this option, any forms that you have opened will remain open. 
To view these forms, all you need to do is close the form you are currently using by clicking on 

the  button located in the upper right area of the form. 
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Reviewing an AR Account Using the TSADETL Form 
You will use the Student Account Detail (TSADETL) form to view current account payment 
and charge information to assist students who have questions about their account. You can also 
enter transactions in this form. See the “Posting a Charge or Payment on a Student Account in 
the TSAAREV Form” section of this manual for more information about entering transactions. 

Opening the TSADETL Form and Reviewing Charge and 
Payment Details 
Instructions 

1. To access the TSADETL form, type TSADETL in the Go To field in the Main Menu. 

2. Press ENTER.  

The TOADEST form only appears before certain forms load, and it only 
appears once per logged in session. If the TOADEST form does not appear, the 
form you want to use will appear. 

 

 
 

3. If the TOADEST form does appear before the TSADETL form loads, then select values 
for two Printer Destinations fields in the TOADEST form. Select identical printers in the 

Invoices and Receipts fields by clicking on the drop-down arrow  to the right of 
each field, and selecting the appropriate printer. 
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4. Click the Exit button . 

The TSADETL form appears. 

 

 
 

5. Type the ID number in the ID field if you have it, or complete a search by clicking on the 
drop-down arrow next to the ID field.  

The Option List dialog box will appear. 

 

 
 

6. Click on Person Search (SOAIDEN) if you need to locate a person’s ID. Click on Non-
Person Search (SOACOMP) to search for companies or other non-person entities. 
Click on Alternate ID Search (GUIALTI) to search based on a person’s SSN. 
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7. Type the person’s or company’s name, and then select F8 to execute a query. 

8. Double click on the ID you want to select. 

The TSADETL form will appear, and the selected ID number will be displayed in the ID field. 

9. Click the Next Block button  to review account charge and payment details. 

The cursor should move into Charges/Payments tab block.  

 

This table lists and describes the values shown in this tab block. 

Charges/Payments 
Fields 

Description 

Detail Code Displays the code associated with the type of transaction you are 
reviewing 

 

Amount The amount associated with the transaction 

Balance The balance associated with the transaction 

Term Displays the term for which the transactions are applied 

Source Displays the source of the transaction (registration, housing, AR, etc.) 

Text This field is used to enter notes, comments, etc. 

Pay Num Free-form information identifying a payment; often used to record 
check or credit card number 

Document Number Displays the number indicating the source document for the 
transaction 

Trans Paid This field indicates the specific transaction that this transaction was 
applied to. 

 

Trans Num Displays a system-generated, specific number that is created for each 
transaction 

 

Receipt Displays the receipt number for the transaction under review 
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Reviewing Date and Invoice Details 
Review transaction date and invoice details in the Date/Invoice tab block, located on the right 
side of the Charges/Payments tab.  

 

 
 

This table lists and describes the values shown in the Date/Invoice tab block. 

Date/Invoice 
Fields 

Description 

Effective Displays the date the transaction becomes effective; this date affects the 
calculation funds due 

The effective date cannot precede the transaction date 

Transaction  Displays the date when the transaction was originally entered 

Bill  This date is generated by Banner’s billing process 

The date is used by the aging process to determine a charge’s past due 
period 

Due  This date is generated by Banner’s billing process 

If the due date is a future date, the amount is not calculated in the 
Amount Due field (located at bottom of form) 

If the date is today or a previous date, the amount is calculated in the 
Amount Due field 

Statement  This date is generated by Banner’s billing process 

This is the date the statement containing the transaction was generated 

 

 
 9 of 38 10/19/2006 

 



 
Transaction Processing 

 

 

Reviewing Feed Cashier Details 
Click on the Feed Cashier tab block to review transaction feed cashier details. 

 

 
 

This table lists and describes the values shown in the Feed Cashier tab block. 

Feed Cashier 
Fields 

Description 

Feed Y = Feed this transaction to Finance 

N = Hold this transaction 

F = Already Fed to Finance 

Feed Doc Number Displays the number indicating through which document this transaction 
was fed into the Banner Finance module 

Feed Date The Date this transaction was fed into Finance 

Session Displays the cashier session number associated with this transaction 

If the number = 0, then the cashier session is still open.  

User Displays the cashier ID for this transaction. 

End Date Displays when the cashiering session was closed 

Create Source Displays where the transaction was created (Example: Cashnet, Banner, 
etc) 
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Reviewing Cross Reference Details 
Click on the Cross Ref tab block to review transaction cross reference details. Every field in this 
block provides data related to third party processes.  

 

 
 

This table lists and describes the values shown in the Feed Cashier tab block. 

Cross Reference Fields Description 

ID Identifies a specific third party entity (ROTC, 
corporate organization, etc.) 

Source References the third party transaction 

Number References the third party transaction 

Detail Code References the third party transaction 
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Reviewing Tax Details 
Click on the Tax tab block to review transaction tax details. This block provides tax-related 
information for the transaction. It is populated by the 1098-T process. 

 

 
 

This table lists and describes the values shown in the Tax tab block. 

Cross Reference Fields Description 

Year Shows the tax year in which the transaction 
was reported on 1098-T form 

Box Box on the 1098-T form that this transaction 
impacted 

Amount The amount of this transaction that was 
reported on the 1098-T form 

Future Term Indicates if this transaction was included in a 
future term 
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Reviewing Account Balance Details 
The Account Balance block does not have a name displayed; it is located at the bottom of the 
TSADETL form.  

 

 
 

This block contains various account balance summary values that you can review. 

The Query Balance field shows the total balance for whatever parameters are shown in the 
Charges/Payments tab block.  

When you want to look at what the account owes for any charges (Example: any charges over 
$2000), follow these steps. 

Instructions 

1. Select Enter from the Query menu in the Menu Bar. 

2. Type 2000 in the Amount field. 

All fields will be blank in the middle block of the form when you conduct 
queries. 

 

3. Select Execute from the Query menu in the Menu Bar. 

You will either receive a message that states that the query retrieved no records, or the 
Account Balance block field will display charge information for all transaction amounts that are 
greater than $2000. 

4. Scroll down to the last transaction by using the right scroll bar to view the cumulative 
balance from your query in the Query Balance field. 
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The Account Balance always shows the total account balance, and does not 
change when other amounts do. 

 

This table lists and describes the other values shown in the Account Balance block that you 
may review. 

Account Balance Fields Description 

Amount Due Displays the current total outstanding amount on the student’s 
account 

Memo Balance Displays the amount of financial aid that the student is eligible to 
receive 

Authorized Aid Displays the amount that Financial Aid Department has authorized, 
but has not been processed through AR 

NSF The number in this field tracks how many NSF incidents for the 
student’s entire history, not just during the current term 

0 =No NSF incidents  

1 = one incident 

etc. 

Receipt field Disregard this field  

NMSU does not process receipts through Banner  

NMSU uses CashNet 
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Reviewing Memo Details 
The fields in the Memos Tab block provide transaction details for financial aid that has not been 
authorized for the student. 

 

 
 

Example: If a student will be receiving $500 from a Pell Grant, one of the Detail Code fields will 
contain the correct code and text description of this potential award. The amount will be 
displayed in the Amount field. 
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Reviewing Comments Details 
The fields in the Comments tab block provide comment information for the student. 

 

 
 

Account Balance Fields Description 

Originator Code for the group that entered the comment. 

Comment Text Text entered about the account. 

Activity Date Date the comment was entered. 

User User ID of the person who entered the comment. 
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Reviewing Account Information in the TSAAREV Form 
The Account Detail Review (TSAAREV) form provides any payment information on the 
student’s account in an easy-to-use display format, so that you can quickly review student 
account information. This form defines various amounts as being either payment or charge 
transactions, and provides most, but not all of the information contained in the TSADETL form.  

You can also enter transactions in this form. See the “Posting a Charge or Payment on a 
Student Account in the TSAAREV Form” section of this manual for more information about 
entering transactions. 

Instructions 

1. To access the TSAAREV form, type TSAAREV in the Go To field in the Main Menu. 

2. Press ENTER. 

If this is the first form you have opened in your current Banner session, the TOADEST form will 
appear as soon as the TSAAREV form begins to load. If you have already been working 
another Banner form that has caused the TOADEST form to appear, then the TOADEST form 
does not appear before the TSAAREV form appears. 

 

 

The TOADEST form only appears before certain forms load, and it only 
appears once per logged in session. If the TOADEST form does not appear, the 
form you want to use will appear. 

 

3. If the TOADEST form does appear before the TSAAREV form appears, then you will 
select values for two Printer Destinations fields in the TOADEST form. Select identical 

printers in the Invoices and Receipts fields by clicking on the drop-down arrow  to 
the right of each field, and selecting the appropriate printer. 
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4. Click the Exit button . 

The TSAAREV form appears. 

 

 
 

5. Type the ID number if you have it, or complete a search by clicking on the drop-down 
arrow next to the ID field. 

The Option List dialog box will appear. 

 

 
 

6. Click on Person Search (SOAIDEN) if you need to locate a person’s ID. Click on Non-
Person Search (SOACOMP) for searching for companies, or other non-person entities. 
Click on Alternate ID Search (GUIALTI) to search based on a person’s SSN. 

7. Type the person’s or company’s name, and then select F8 to execute a query. 
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8. Double click on the ID you want to select. 

The TSAAREV form will appear, and the ID number you selected will be displayed in the ID 
field. 

9. Click the Next Block button  to review detailed account information. 

The cursor should move into Account Details block.  

10. Use the bottom and side scroll bars to see all fields. 
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Reviewing Student Account Summaries in the 
TSAACCT Form 
The Student Account Review (TSAACCT) form provides a student’s account summary. You 
can’t enter transactions through the TSAACCT form. See the “Posting a Charge or Payment on 
a Student Account in the TSAAREV Form” section of this manual for more information on 
entering transactions. 

Instructions 

1. To access the TSAACCT form, type TSAACCT in the Go To field in the Main Menu. 

2. Press ENTER. 

If this is the first form you have opened in your current Banner session, the TOADEST form will 
appear as soon as the TSAACCT form begins to load. If you have already been working 
another Banner form that has caused the TOADEST form to appear, then the TOADEST form 
does not appear before the TSAACCT form appears. 

 

 

The TOADEST form only appears before certain forms load, and it only 
appears once per logged in session. If the TOADEST form does not appear, the 
form you want to use will appear. 

 

3. If the TOADEST form does appear before the TSAACCT form appears, then you will 
select values for two Printer Destinations fields in the TOADEST form. Select identical 

printers in the Invoices and Receipts fields by clicking on the drop-down arrow  to 
the right of each field, and selecting the appropriate printer. 
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4. Click the Exit button . 

The TSAACCT form appears. 

 

 
 

5. Type the student’s ID number in the ID field if you have it, or complete a search by 
clicking on the drop-down arrow next to the ID field. 

The Option List dialog box will appear. 

 

 
 

6. Click on Person Search (SOAIDEN) if you need to locate a person’s ID. Click on Non-
Person Search (SOACOMP) for searching for companies, or other non-person entities. 
Click on Alternate ID Search (GUIALTI) to search based on a person’s SSN. 

7. Type the person’s or company’s name, and then select F8 to execute a query. 
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8. Double click on the ID you want to select. 

The TSAACCT form will appear, and the ID number you selected will be displayed in the ID 
field. 

9. Click the Next Block button  to review the student’s account status. 

The cursor should move into Account Status block.  

 

This table lists the values shown in the Account Status block that you may review, and their 
description.  

Account Status Fields Description 

NSF The number in this field tracks how many NSF 
incidents for the student’s entire history, not 
just during the current term 

0 =No NSF incidents  

1 = one incident 

etc. 

Bill Code This code indicates if the account is in 
collections, bad debt, etc. 

Click on the drop-down arrow  to the right 
of the Bill Code field to view all bill codes 

Delinquency This code indicates the level of delinquency on 
the student’s account  

Click on the drop-down arrow  to the right 
of the Delinquency field to view all 
delinquency codes 

 

10. Click the Next Block button . 

The cursor should move into Account Balance block. This block provides a summary of an 
account based upon account transactions, including effective date aging, current and past due 
amounts, unapplied credit, and bill date aging. 

11. Review the student’s account balance information. 
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12. Click the Next Block button . 

The cursor should move to the Exemptions block. This block lists all current and past 
exemptions for the student. 

 

 
 

13. Review exemptions on the student’s account, if any exist.   

14. Click the Next Block button . 

The cursor should move to the Contracts block. This block lists all current and past third party 
contracts for the student’s account. 

 

 
 

15. Review all third party contracts for the student’s account, if any exist.   

16. Click the Next Block button . 

The cursor should move to the Collections block. This block provides detailed information 
related to the collections history, such as which agency that the student’s account was referred 
to, and the date. 
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17. Review all collections information for the student’s account, if any exist. 

18. Click the Next Block button . 

The cursor should move to the Installment Plan block. This block provides detailed information 
regarding the student’s current and past installment plans. 

 

 
 

19. Review the student’s installment plans, if any exist. 
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Posting a Charge or Payment on a Student Account in 
the TSAAREV Form 
Adjustments to an account will occasionally need to be made by posting charges and/or credits 
through Banner. This process illustrates how to perform this task. 

Instructions 

1. To access the TSAAREV form, type TSAAREV in the Go To field in the Main Menu. 

2. Press ENTER. 

The TOADEST form only appears before certain forms load, and it only 
appears once per logged in session. If the TOADEST form does not appear, the 
form you want to use will appear. 

 

 
 

3. If the TOADEST form does appear before the TSAAREV form appears, then you will 
select values for two Printer Destinations fields in the TOADEST form. Select identical 

printers in the Invoices and Receipts fields by clicking on the drop-down arrow  to 
the right of each field, and selecting the appropriate printer. 
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4. Click the Exit button . 

The TSAAREV form appears. 

 

 
 

5. Type the ID number in the ID field if you have it, or complete a search by clicking on the 
drop-down arrow next to the ID field. 

The Option List dialog box will appear. 

 

 
 

6. Click on Person Search (SOAIDEN) if you need to locate a person’s ID. Click on Non-
Person Search (SOACOMP) for searching for companies, or other non-person entities. 
Click on Alternate ID Search (GUIALTI) to search based on a person’s SSN. 

7. Type the person’s or company’s name, and then select F8 to execute a query. 
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8. Double click on the ID you want to select. 

The TSAAREV form will appear, and the ID number you selected will be displayed in the ID 
field. 

9. Click the Next Block button  to review detailed account information. 

The cursor should move into Account Details block.  

10. Use the bottom and side scroll bars to see all fields. 

11. Click the Next Block button  to review detailed account information. 

The cursor should move into Account Details block.  

12. Either place cursor into a blank Detail Code field, or click the Insert Record button 

. 

13. Type the appropriate detail code for the transaction you are going to process in the 

Detail Code field. Click on the drop-down arrow  above the Detail Code fields, or 
select F9 to view all detail code options. 

14. Tab to the Term field, and type the term that corresponds to the type of transaction you 
want to process.  

15. If the cursor moves to the Charge field, type the charge amount in this field. If the cursor 
moves to the Payment field, type the payment amount there.  

16. Click the Save button  to apply and save the transaction. 

The message line at the bottom of the form will either indicate that the transaction has been 
applied and saved, or it will display an error message. 

17. If you receive an error message, the transaction will not be applied and saved until the 
error is corrected. If you cannot correct the error, or you do not want to save the 
transaction, place the cursor in the transaction you want to remove, and click the 

Remove Record button . 

Once a transaction has been applied and saved, you cannot remove it. See the 
“Correcting Transactions in the TSAAREV Form” section of this manual if you need 
to make changes to a transaction that has been applied and saved. 
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Posting Mass Charges and Payments in the TSAMASS 
Form 
The Billing Mass Data Entry (TSAMASS) form will allow the same type of charge or payment 
to be posted to multiple student accounts.  Mass Payments that might be entered in the 
TSAMASS form are Wire Transfers and Hadley Deposit. Mass Charges that might be entered in 
the TSAMASS form are Band Uniforms and Art Supplies. 

Instructions 

1. To access the TSAMASS form, type TSAMASS in the Go To field in the Main Menu. 

2. Press ENTER. 

If this is the first form you have opened in your current Banner session, the TOADEST form will 
appear as soon as the TSAMASS form begins to load. If you have already been working 
another Banner form that has caused the TOADEST form to appear, then the TOADEST form 
does not appear before the TSAMASS form appears. 

 

 

The TOADEST form only appears before certain forms load, and it only 
appears once per logged in session. If the TOADEST form does not appear, the 
form you want to use will appear. 

 

3. If the TOADEST form does appear before the TSAMASS form appears, then you will 
select values for two Printer Destinations fields in the TOADEST form. Select identical 

printers in the Invoices and Receipts fields by clicking on the drop-down arrow  to 
the right of each field, and selecting the appropriate printer. 
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4. Click the Exit button . 

The TSAMASS form appears. 

 

 
 

5. To post a mass charge in the TSAMASS form, insert the appropriate values in one or 
more of the fields in the top block.  

The data you enter determines what default values will appear in the 
Charges/Payments block. 

6. Click the Next Block button  to move the cursor to the Charges/Payments block. 

7. Type the first student ID number in the first ID field. 

8. Type the charge amount in the first Amount field. 

9. Click in the second blank ID field and type the next student’s ID number in the ID field. 

10. Type the charge amount in the second Amount field. 

11. Continue entering your remaining student ID numbers and corresponding payment 
amounts.  

12. Click the Save button  to apply and save the transaction. 
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Correcting Transactions in the TSAAREV Form 
You cannot remove a transaction if it has been applied and saved. You can correct a 
transaction in the TSAAREV form if you need to make changes to a transaction that has been 
applied and saved (this is also called “backing out a transaction” or “reversing a transaction”). 
For example, if a charge has been incorrectly placed on an account, then you could reverse the 
charge by creating anther charge of the same type, or detail code with a negative amount, to 
cancel the original, incorrect charge. 

If an error is found in an accounts tuition calculation, all attempts should be 
made to correct the reason why the tuition was calculated incorrectly. See the 
training manual concerning Fee Assessment (i.e., Student Attributes, Enrollment 
Status, etc.) and then rerun the fee assessment process. Manually adjusting 
tuition fee calculations is not recommended, except for unusual cases. 

Instructions 

1. To access the TSAAREV form, type TSAAREV in the Go To field in the Main Menu. 

2. Press ENTER. 

If this is the first form you have opened in your current Banner session, the TOADEST form will 
appear as soon as the TSAAREV form begins to load. If you have already been working 
another Banner form that has caused the TOADEST form to appear, then the TOADEST form 
does not appear before the TSAAREV form appears. 

 

 

The TOADEST form only appears before certain forms load, and it only 
appears once per logged in session. If the TOADEST form does not appear, the 
form you want to use will appear. 

 

3. If the TOADEST form does appear before the TSAAREV form appears, then you will 
select values for two Printer Destinations fields in the TOADEST form. Select identical 

printers in the Invoices and Receipts fields by clicking on the drop-down arrow  to 
the right of each field, and selecting the appropriate printer. 
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4. Click the Exit button . 

The TSAAREV form appears. 

 

 
 

5. Type the ID number if you have it, or complete a search by clicking on the drop-down 
arrow next to the ID field. 

The Option List dialog box will appear. 

 

 
 

6. Click on Person Search (SOAIDEN) if you need to locate a person’s ID. Click on Non-
Person Search (SOACOMP) for searching for companies, or other non-person entities. 
Click on Alternate ID Search (GUIALTI) to search based on a person’s SSN. 

7. Type the person’s or company’s name, and then select F8 to execute a query. 
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8. Double click on the ID you want to select. 

The TSAAREV form will appear, and the ID number you selected will be displayed in the ID 
field. 

9. Click the Next Block button  to review detailed account information. 

The cursor should move into Account Details block.  

10. Use the bottom and side scroll bars to see all fields. 

11. Identify the transaction in the Account Details block that needs to be corrected. 

12. Select an empty Detail Code field, and type the same detail code as the one used for 
the transaction you want to correct (Example: “CHCK”). 

13. Type text in the Description field that indicates that this transaction is a reversal of the 
one you want to correct (Example: ”Check-Correction to TNUM 6”). 

14. Type the same term in the Term field as the one used for the transaction you want to 
correct (Example: 200640). 

15. If the transaction charge or payment is a positive (+) number, then you will type the 
same number as a negative number. If the transaction charge or payment is a negative 
(-) number, then you will type the same number as a positive number. 

16. Click the Save button  to apply and save the transaction correction. 
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Processing a Returned Check Using the TSAAREV 
Form 
Instructions 

1. To access the TSAAREV form, type TSAAREV in the Go To field in the Main Menu. 

2. Press ENTER. 

If this is the first form you have opened in your current Banner session, the TOADEST form will 
appear as soon as the TSAAREV form begins to load. If you have already been working 
another Banner form that has caused the TOADEST form to appear, then the TOADEST form 
does not appear before the TSAAREV form appears. 

 

 

The TOADEST form only appears before certain forms load, and it only 
appears once per logged in session. If the TOADEST form does not appear, the 
form you want to use will appear. 

 

3. If the TOADEST form does appear before the TSAAREV form appears, then you will 
select values for two Printer Destinations fields in the TOADEST form. Select identical 

printers in the Invoices and Receipts fields by clicking on the drop-down arrow  to 
the right of each field, and selecting the appropriate printer. 
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4. Click the Exit button . 

The TSAAREV form appears. 

 

 
 

5. Type the ID number if you have it, or complete a search by clicking on the drop-down 
arrow next to the ID field. 

The Option List dialog box will appear. 
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6. Click on Person Search (SOAIDEN) if you need to locate a person’s ID. Click on Non-
Person Search (SOACOMP) for searching for companies, or other non-person entities. 
Click on Alternate ID Search (GUIALTI) to search based on a person’s SSN.  

7. Type the person’s or company’s name, and then select F8 to execute a query. 

8. Double click on the ID you want to select. 

The TSAAREV form will appear, and the ID number you selected will be displayed in the ID 
field. 

9. Click the Next Block button  to review detailed account information. 

The cursor should move into Account Details block.  

10. Place the cursor in the first blank Detail Code field.  

11. Type the appropriate campus detail code in the Detail Code field. 

 

Campus Detail Code 

Main RTMA 

Alamogordo RTAL 

Carlsbad RTCA 

Dona Ana Community College RTDA 

Grants RTGR 

 

12. Enter the check amount in the charge field. 
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13. Click the Save button  to apply and save the transaction. 

 

 
 

When you save a returned check transaction, Banner automatically calculates 
a bad check service fee of $25, and adds this charge to the student account 
balance. 

 

 

 
10/19/2006 36 of 38  

 



 
Banner User Guide 

 
 

Reviewing and Adjusting Cashiering Sessions  
A cashiering session is created whenever any charge or payment activity is entered into the 
Banner system. Reviewing cashiering sessions ensures that all funds are accurately recorded 
before they are posted to Finance. The Cashier Session Review (TGACREV) form is used to 
review your cashier sessions. The TSAAREV form is used to view detailed information 
associated with your sessions, if you have any discrepancies between amounts listed in your 
daily balance sheet and the amounts shown in the TGACREV form.   

Reviewing and Adjusting Your Cashiering Session 
Instructions 

1. Use your daily balance sheet to compare charge amounts and other charge information 
listed in the TGACREV form when you conduct cashiering session reviews. 

2. To access the TGACREV form, type TGACREV in the Go To field in the Main Menu. 

3. Press ENTER.  

The TOADEST form only appears before certain forms load, and it only 
appears once per logged in session. If the TOADEST form does not appear, the 
form you want to use will appear. 

 

 
 

4. If the TOADEST form does appear before the TGACREV form loads, then select values 
for two Printer Destinations fields in the TOADEST form. Select identical printers in the 

Invoices and Receipts fields by clicking on the drop-down arrow  to the right of 
each field, and selecting the appropriate printer. 
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5. Click the Exit button . 

The TGACREV form appears. 

 

 
 

6. Type your user name in the Session User field. 

7. Click the Save button . 

8. Review the detail codes and the amounts posted to each in the Cashier Session Detail 
block. 

9. In the Options menu, click Review Cashier Session Detail. If the total charges and 
payments listed in the TGACREV form do match the total charges and payments listed 
in your daily balance sheet, go to step 11. 

10. Review all transactions listed in the TGACREV form, and correct any differences 
between transaction information listed in the TGACREV form and your balance sheet.  If 
any corrections need to be made in Banner, copy the ID number, amount, and detail 
code for the transaction in question, and then make your corrections in the TSAAREV 
form. Follow the procedure provided in the “Correcting Transactions in the TSAAREV 
Form” section of this manual if you need to make any corrections. 

11. In the Options menu, click Close Session when all amounts listed are in both the 
TGACREV form and your daily balance sheet are the same.  
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